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1. Atencion

1. Quite el material de produccion antes de usar la maquina.

2. Sea en el costado como en el dorso, asegure de que el voltaje coincida con el
especificado.

3. Conecte el cable de fuente con el botdn de encendido en “off”.
4. No toque el cable de fuente con las manos mojadas para evitar shock eléctrico.
5. Por favor utilice el cable y la linea de datos aprobada por el fabricante.

6. Prevenir que caiga material metalico o liquido dentro de la maquina ya que puede
causar malfuncionamiento.

7. Espere 15 segundos para reiniciar la computadora si hubo un corte de luz para
preservar la maquina.

8. Desenchufe la maquina durante dias de tormenta.
9. No remplace componentes de manera personal.

10. El fabricante tiene el derecho de modificar la especificacion del producto sin
informar.

11. El fabricante Unicamente es responsable de la obligacion legal del producto, no de
las perdidas ocasionadas por el producto en si mismo.

12. Sin nuestra aprobacién, ninguna persona puede copiar o distribuir este material.



TIP
0 1. tapa 6. LCD
PE 2. rodillo de presidn 7. Cubierta derecha
3. rodillo de metal 8. Panel de Control

4. carro 9. Soporte de cuchilla
5. switch de reset 10. Cubierta izquierda

11. Cable de poder
12. fusible
@om / oy 13. fuente de alimentacidn
IPRVAY e 14. Puerto USB

o 15. Puerto serial
Lado izquierdo Lado derecho

TIPO 1. tapa 6. panel de control
2. rodillo de presion 7. cubierta derecha
XE 3. rodillo de metal 8. switch de reset
4. carro 9. soporte de cuchilla
5.LCD 10. cubierta izquierda
11. cable de poder
12. fusible
13. fuente de alimentacidn
14. puerto USB
15. puerto serial
Lado izquierdo Lado derecho
] . i Y @
1. tapa 6. panel de control
2. rodillo de presidn 7. cubierta derecha
TIPO 3. rodillo de metal 8. soporte de cuchilla
XL 4. carro 9. cubierta izquierda
5.LCD

10. cable de poder

11. fuente de alimentacién
12. puerto USB

13. puerto serial

Lado izauierdo Lado derecho



=538 TIPO

HE 1. tapa 6. carro
2. rodillo de metal 7. cubierta derecha
3. rodillo de presion 8. soporte de cuchilla
4.1CD 9. cubierta izquierda

5. panel de control

10. puerto de poder

11. fusible
~ | 12. fuente de alimentacion
o e - I 13. puerto USB
o \ap\¢ | 14. puerto serial
Lado izquierdo Lado derecho

3. Especificacion

HPe 720 870 1100 1350
especificacion
Ancho max. bandeja 720mm 870mm 1100mm 1350mm
Ancho max. corte 630mm 780mm 1010mm 1260mm
Grosor de corte =1mm
Velocidad 800mm/s 800mm/s 800mm/s 800mm/s
Fuerza 500/g 500/g 500/g 500/g
Buffer 1-4M 1-4M 1-4M 1-4M
LCD si si si si
Control en tiempo real soportado soportado soportado soportado
Interface Serial + USB | Serial + USB | Serial + USB Serial + USB
Funcion Repetir soportado soportado soportado soportado
Repetibilidad 0.127mm
Resolucion
Mecinica 0.0245mm/step
Conjunto de mandos DMPL/HPGL
Alimentacion AC 85V-AC 264V
Condiciones temperatura: +5'C+35°C humedad: ( 30%-50% ) sin
ambientales condensacién




4. Accesorios y bosquejo de ensamblaje

Accesorios

Mapa de croquis de hierro

Name Quantity Note ’,./// L-\ \\ Crossbeam and column
[ | “ delall drawing
1 | Cable de poder 1 L L |
2 Cuchilla 1 ‘W- ol
3 | Sostén de cuchilla 1 19 ‘ |
4 | Sosten de lapiz 1 |
5 Lapiz 1
6 | Cable de serie 1 NH
7 Cable USB 1 |
8 Llave Allen 1 ||
9 Driver USB 1 Incluye manual : ‘l
: - : =
10 | Tomillo de soporte Opcional — _
11 Guardapolvo 1 Opcional / ¥
P ]1‘]' l<:‘<r :.ru“i«fvl m (\—‘ = ’r"___ - '_")
delail drawing \\\ -/‘//

Croquis de stand de aluminio

/ Crossbeam

and column

\ Y L

N
BN - drawing

Pillar barand
column geta

Croquis de stand XL

1:Back vinyl hanger 2: Caiumn 3: Corssbeanm
Install each componens as number below to /
ensure the holes aligned and then fasten the |
screws. \

" Front vinyl hanger is a
mavable component that

can be fasten it bya

pentagon screw.

.»a- ’

dﬂ/ - C
s

-

s 5 - Connect the column to the pillar ba



5. Operacion de la maquina

1, Apoyar la maquina en una superficie plana y conectarla con un cable a tierra. Asegurarse de que la
maquina tenga espacio.

2, Encender con botdn, la luz LCD se prendera, el carro se movera a la derecha, el rodillo de metal hacia
adelante y atrds. Esto demuestra que la maquina se ha reseteado por completo.

3, El soporte de la cuchilla se levantara luego de encender. Ahora apretar botdn “origin”. El soporte de la
cuchilla descendera. Al soltar el botdn ascenderd nuevamente. Esto demuestra que el carro funciona
correctamente.

4, Al apretar botdn “offline”, la luz amarilla se encendera. Apretar “«”o“»”para desplazar el carro y
“W”0" A” para mover la barra de metal; si se presiona “V¥”or“ A” a la vez, activara la inspeccién
automatica del programa.

6. LCD y Panel de Control

Plotter start screen. It will
| take 3 seconds for machine
initialization.

After Initializing, the machine
automatically reset. Under
PPN —1 this interface you can adjust
Off-line interface. In this F the cutting speed and force,
status, you can move the O ( / o — test the machine, do on-line
carrlage or metal roller ' a
by pressing the button
to check the quality of the
pattern or to set the origin

location. y J Pressa

!

This screen shows the baud
rate and speed grade, You
can sel up the baud rate in
this interface.

ry Press

|Press

Plotter will record the last output
data. Under this interface machine|
is ready fo re-cut.

1. Cambiar la pantalla a ésta interfaz:
1. La maquina puede conectarse con la computadora bajo esta interface.

2. Para ajustar la fuerza de corte y velocidad: “<” o“»” para fuerza de corte. Y “V¥”0 “ A” para para

velocidad.

3. Al presionar el botén “test”, la maquina cortara el patrén “<” en el vinilo. Usarlo para medir si la
fuerzay la anchura son propicias.



2. Cambiar la pantalla a interfaz offline mientras el indicador amarillo se prende.

1. Localizar el origen manualmente, apretando “<”o “»”para trasladar el carro. Presionar los botones
“VW”0“A” paramover el rodillo de metal, y detenerse en una posicidn ideal. Luego presionar “origin”
para conformar origen. Presionar “offline” para deshacer todos los movimientos anteriores.

3. Cambiar la pantalla a tasa de banda mientras el indicador verde se prende.
1. Para configurar tasa de banda: Presionar botdn “<” o “»” hacia tasa de banda “9600”.

4. Cambiar la superficie a mientras tanto el botdn verde y amarillo se prenderan.

1. Para activar funcidn repetir: dentro de la funcién redraw, presionar botén “origin” para activar el
proceso redraw.

5. Funcién pausa

1. Durante el periodo de procesamiento, si ocurre una emergencia y se debe pausar, presionar el botén
“offline” para que deje de trabajar y se encendera el indicador amarillo.

Presionar “offline” nuevamente para salir.

7. Cuchilla

Atencion
No cortar la punta de la cuchilla con el dedo, puede provocar un accidente.
1. Insertar la cuchilla en el sostén de cuchilla S
h..
(Outside view) (breakdown drawing)
d F;ch rod Cutterhoidershellr Cutter
// X - \
/ Yo% B \
:i L rﬂv:-f A
- | —
cutter holdeLQQQx“ Adjusting screw
2. Ajuste

Aflojar el tornillo de ajuste > rotar el tornillo saliente> la profundidad de la cuchilla dependera del grosor
del material. ' z 3

\ 1
\
of bottom layer

too long the protruding length too short

3. Presionar la barra de la cuchilla para reemplazarla.
4. Colocar el soporte de la cuchilla en soporte del carro

(1) Aflojar el tornillo de fijacion
(2) Colocar el soporte de la cuchilla en él.

(3) Ajustar el tornillo




8. Material de alimentacion

1. Colocando el rodillo de pellizco dependiendo del material

La maquina tiene dos o cuatro rodillos de presidn y pueden ser trasladados a lo largo del carril. Levantar la
manija y mover el lado trasero del rodillo de pellizco al lugar indicado.

(1) El rodillo de pellizco debe estar colocado en el drea con moleteado y capa de arena
(2) El rodillo de pellizco debe tener entre 10 y 50mm de distancia del borde del material.
2. Material de alimentacion
(1) Levantar la manija.
(2) Alimentar el vinilo, desde el medio del rodillo de pellizco y el rodillo de metal
(3) Presionar el material hacia la posicion indicada y luego bajar la manija.

(4) Presionar “offline” para mover el material hacia adelante y hacia atras, observe el borde del
material en la placa de escala. Si durante el movimiento el material tiene una desviacién hacia la
derecha, entonces levante el rodillo de pellizco. Empuje el material un poco hacia atras y baje la
manija nuevamente. Ajuste el material reiteradas veces hasta encontrar posicion.

9. Testeo

1, Testeo de la maquina

Antes de procesar, deberiamos hacer un “testeo” para chequear la presion de la cuchilla/lapicera.
Presionar el botdn “offline” (el indicador amarillo se encenderd), mientras presionar el botén “V¥” y “A”
y la cuchilla dibujard/cortara el patrén “<” en el vinilo.

2, Ajustando la presion

En el LCD, los valores altos significan presion alta. Valores bajos significan presion baja. Ajustar el valor
acorde al grosor y a la flexibilidad. Si a presidn es baja, el vinilo no se cortara. Si la presién es muy alta,
puede causar la deformacion del patrén.

3. Asegurarse de que la punta de la cuchilla siempre toque con la superficie del vinilo, la perfecta
profundidad es de dos tercios del grosor del material para evitar cortar la superficie debajo.

4, Use mucho menos presidn con el soporte de la lapicera.

5, Rehacer el testeo luego de encender o de cambiar el material para lograr una fuerza de corte éptima.



10. Transfiriendo el Patréon

Proceso de cortado completo:

1, Use un cuchillo parar cortar el patrén

2, Use pinzas para despegar la parte no deseada. (Para despegar facilmente, agregue un
rectangulo alrededor el patrdn)

3, Usar “filmina de pasaje” para pegar el patrén entero, de manera suave para evitar las arrugas y
burbujas.

4, Despegar la “filmina de pasaje” con el patrdn sobre ella, luego pegarla en el lugar deseado y
despegar la “filmina de pasaje” nuevamente.

5, Una vez finalizado el trabajo, descargar el material; limpiar cuidadosamente el soporte de la
cuchilla; apagar la maquina, desenchufar el cable de poder; cubrir la maquina con cubierta a
prueba de polvo.

11. Posibles problemas

1. éPorque la letra es deforme o incompleta?

1, Punta de cuchilla muy larga, fuerza de corte muy alta, plato muy sucio (restos de sticker), o sticker muy
flojo.

2, La configuracién del software es incorrecta. (Por ejemplo, la funcién de compensacion de herramienta
esta abierta y con valores muy altos).

3, El rodillo de metal o engranaje de motor suelto; de esta manera el rodillo de metal o carro no puede
moverse por el motor causando la deformacion.

4, La letra esta incompleta. Usualmente esto sucede cuando la el valor de compensacién es muy bajo.

2. é{Porque la maquina dibujo anormalmente?

1, La configuracién del software es inapropiada: Seleccione el conjunto de comandos correcto en el tipo
de plotter (seleccionar DMPL/HPGL); si el archivo de formato es algo grande, y necesita la herramienta de
compensacion, debe poner tick en el delay por 10 milisegundos.

2, Archivo interrumpido durante transmisién de sefial.

3. El software del plotter esta dafiado o la computadora tiene un virus.

4, Si hay una conexién inalambrica puede causar interferencia. ( la transmision paralela es sensible a esta
interferencia, recomendamos usar el puerto de serie.)

5, Si usa un estabilizador de voltaje incompatible, puede generar interferencias e interrupciones que
causen errores en la comunicacion de datos.

6, Los chips del motherboard estan dafiados (WS628128LLPG, MAX232CPE, STC90C52RC, ATF16V8B).

3. éPorque la maquina se corrid de posicion?

1, El vinilo mal dispuesto: Si un vinilo de 60mm de ancho se desvia 0.6mm, cada 5 metros habrd una
desviacién de 5mm.

2, El plato esta sucio y tiene residuos de vinilo: La friccidn esta desnivelada causando desviacion.

3, El rodillo de pellizco tiene baja presion: El vinilo puede desviarse por fuerzas externas.

4, Presion desnivelada entre los rodillos.



5, Alguna falla en el motor puede causar desviacidn.
6, Si se recalienta el chip A4975SBT puede causar desviacion.

4. {Porque no funciona el motor correctamente?

1, El material es grueso y duro: El motor no tiene la suficiente energia para manejarlo.

2, El driver del chip IC es anormal.

3, El moleteado estd sucio causando un pequefio coeficiente de friccién entre el material y el rodillo
metalico.

5. éPorque la maquina corta irregularmente?

1, La tira entro en una ranura o la nueva tira es desigual y forma una pendiente.

2, El paralelismo del carril esta desigual.

3, La longitud sobresaliente de la punta de la cuchilla es incorrecta. La manera correcta es ajustarla a 2/3
del grosor del vinilo. Asegurarse de que no corte el respaldo con gran presion.

6. ¢Como chequear la calidad del patrén el progreso de corte?

Presionar el botdon “offline” (indicador amarillo encendera) el proceso de corte se pausara, presionar el
botdn “ V" para ver el Patron moviendo el rodillo de meta. Presionar “offline” nuevamente (el indicador
amarillo), el vinilo y el carro volvera a la posicidn y seguiran cortando.

7. éQuiere recortar el patron nuevamente, pero al comenzar la funcidn de repetir el vinnilo se movio a
la siguiente letra?

Esto sucede porque tiene activada la funcién automatica. Cancélela y podra comenzar desde la posicién
anterior.

8. ¢Porque los 3 indicadores se encienden persistentemente?

1, Los chips del motherboar WS628128LLPG, STC90C52RC, ATF16V8B estan rotos.
2, El oscilador de cristal CQ24.000 esta roto.

3, A4975SBT chip drive roto.

10. ¢Porque el carro no se levanta al encender la maquina?

1, TIP122 audion, TIP127 audion, LM324N/TLO84CN audion estan rotos
2, El circuito entre el carro y el motherboard no funciona.

3, El cable de carruaje esta dafado.

11. Al encender, las tres luces del panel del control no encienden y solo funciona el ventilador.
La potencia de 5V no estd conectada o puede estar el cable dafiado.

12. Al encender la maquina, el LCD se enciende pero la luz no muestra letras?
ATF16V8B, SN74LS245N, STC90C52RC, CQ24.000 o cables entre LCD y motherboard pueden estar rotos.

13. Al encender la maquina, el carro no se resetea, o el carro/rodillo de metal se mueve con sonidos
extrafos.

1, A4975SBT o SN74HC374N chip

2, Eje X0 Y se rompieron.

14. Al encender, no funciona el ventilador ni la maquina.
Revisar el fusible, si estd bien, puede ser una falla de la alimentacion.



Archivo adjunto 1: Driver de instalacion de USB

1, Abrir el disco> Abrir carpeta USB Windows Driver> doble click en CH341SER.EXE

Name - Name ;
&4 VD Drive (G) MyDisc
-~ .
i aosss 1. Printer Windows Driver
: % LK:‘;NM » I Software patch »
RN ). USB Mac Driver
[ ..USB\Mndefivu

2, Click Install>Click OK> Salir de instalador del programa.

A S i powT e % ) & Driversetup ——— hqr'":w
Device Driver Install / Uninstall Device Driver lnstall / Uninstall Device Driver Install | Uninstall {
Select INF File :  CHI41SER.INF - [ Oonbast BUE Gl s CMILLCER INE - Select INF File :  CH341SER.INF -
S Y ‘ DerverSetup w 3 2 e
WCH.CN ———— CH.CN
INSTALY |__ USB-SERIAL CH340 | [ NETALL ‘ |_ USB-SEFUAL CH340|
L 11/04/2011, 3.3.2011.11 ‘ 0 The deive s successfully Pre-installed in advance ( 1100412011, 3.3.2011.11
UNINSTALL | UNINSTALL }
HELP ( 0 ] | e \

3, Abrir el Device Manager>Elegir en la barra de puertos USB-SERIAL CH340(COM*) >click derecho en
USB-SERIAL CH340(COM*) > propiedades> configuracién de puertos> avanzada> cambiar el COM Port
Number a (COM2) > OK

En el Device Manager encontrara que el nimero de puerto USB-SERIAL CH340 cambiard a COM?2
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«* B0 IR aS el v A [ R R

2 Compusn Miapumers Aoca] + g Vg
. Sy Taok -
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o bacane: [ - V' Use AIFO bufiers fequres 16550 compattie UART)
g Seect brwe segs o cornt correcten pratier
o ~
ek Select gher setings for faster pedormance
o - Recene Buser Low (1) J meow 04
[r=—mnlr=—ry
' Tranamt Bufler: Low (1) U oHhos 08
COM Pot Numbar: | COM2 -
e tee ) || e -




Archivo adjunto 2: Configuracion de Software Artcut
1, Conectar la maquina a la computadora por medio del cable USB
2, Instalar software Artcut, escribir una palabra> Cut Out

3, Instalar plotter de corte: Los fabricantes eligen Jinka> Device: dependiendo del actual modelo>clickear
add> cerrar

4, Link to: seleccionar COM2

5, Setup:port setting> Parameters> band rate: 9600 dat bit : 8 check : None stop bit 1
Sequential control : RTS/CTS > OK > Change

6, Clickear Cut/Plot> Start ; la maquina emitira los datos.
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Archivo adjunto 3: Corel Draw operacion del software

Es necesario instala una impresora antes de usar CoreDRAW para emitir. CoreDRAW no es un software
de Plotter profesional por lo que su performance no es igual que un software profesional. No tiene nada
que ver con el dispositivo.

1, Conectar la maquina y la computadora a través de | cambre usb

2, Abrir Devices and Printers. Seleccionar: Add a printer> Add a local printer > Usar un puerto existente>
COM2 > Next > have disk...> Browse > In the Drive My Disc > select Printer Windows Dirver folder >
select GOLDCUT JK Series > Open > OK > Next > Next > in the pop up dialog box select Install this
software anyway > Next > Finish.

3, Boton derecho en la impresora “GOLDCUT JK Series” > seleccionar: printer properties > select : printer

properties > General > Preference > Layout > Advance > paper sizes (seleccionar el ancho mayor) > OK

> OK > Ports > select COM2 > configure port > bits per second 9600 dat bits : 8 check : None stop bits 1 >

Secuencial control : hardware > OK >0K




- — - e b . | m

e o o B | . e b =]
-« G e
You e maenfelly sided GOLDCUT K Seses _ =
» ————
i
T

LR R ————

Ll

- A e

et 1 e . Tt <8 e e g b
S

[t ] remlortey.

o) ) ~ [ A, . [

v L e N e
B By At | G Sr— | Sy | G- —

D By " vt | G g | S | S—J— | | o S| — ——
i i Lo T L - e
4 | T b ‘
[R==S - = ot
[ 2 ‘
- 2 - 2000
| k -
R = |l pec sy
IE- e sz
- 2 -
= e e
| o N
-
SR T
| ot e ] | e |
: alie=

4, Abrir CorelDRAW y tipear palabras simples.

Desde la barra de herramientas a la izquierda: : Qutline > Hairline > Fill tool > None > Print > select
printer GOLDCUT JK Series > Layout > Print tiled page > Apply > Print
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Archivo adjunto 4 Flexi 11 Operacion del software

1. Login
1) Usar computadora con conexcion a Internet.

2) Por favor usar (Google Chrome) y visitar https://www.saicloud.com/

3) Ingresar cAdigo de activacidn que puede ser encontrado en la caja del Flexill (Note que las letras en
Inglés deberan estar en mayusculas), luego clickear Activate.

4) Crear una cuenta: elegir: | am new to the SAi Cloud, ingresar una direccién de mail que use usualmente,

clickear en Create Account.

R o e S Y
’5{ Clsud
Welcome to the SAi Cloud.
Activation Code Login
= =3

@1

] —— S Vo a
Optmes
Step 1. Logn to your SAI Cloud Account
Conate A Frae SAJ Clous Account
w3
> -t ‘
- W Ll J i

.
E

5) Ingresar en casilla de mail y abrir el mail recibido por SAi Cloud. Clickear el enlace del mail. Llenar el
espacio con * arriba a la izquierda. Presionar Create Account.

6) Elegir: | Accept the Terms and Conditions.

Create Account

i

s = o w -  w—

7) Seleccionar: Activate Now
8) Finalizar registro.

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This Software Icense will be added to your SAl Cloud Account

Activale Now

Terms And Conditions

Terms and Conditions
Jepr Agreemwo

IMPORTANT —READ CAREFLLLY.

This ACCOunt Usirs Agreanient I & WOM CONtrac] Betuen YOO (Cened Sexm
and

SA rtamatons i

BY LISING YOUR SAI GLOUD ACCOUNT. YOU (AS THIS TERM IS DEFINED
BELOW) AGREE BY CLICKING ON TME "ACCEPT” BUTTON TO BE BOUND
BY THE TERMS OF THIS AGREEMENT (AS THIS TERM 15 CEFINED BELOW)
INCLUDING, BUT NOT LIMITED TO, ANY WARRANTY DISCLAIMERS.
LIMITATIONS OF UABIITY, JURISDICTION, AND TERNINATION
PROVISIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, 0O NOT OPEN AN SAI CLOUD ACCOUNT AND EXIT NOW

1 ACCOUSE T your s o] on the SAI Coos
2 AQemant means Tus End-User AZCount Ageanen!

3 Lty medcs 30y Ndnatesl DA wreed



https://www.saicloud.com/

2. Instalacién del Software.
1) Instalar el software desde CD.

DVO Drive (G) FS Anka 11 Ed
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In some computer may
appear this dialog box,
click ok directly.

2) Sila computadora tiene internet
Ingresar el cddigo de activacion que se encuentra en la caja de instalacion del Flexill (Note que las letras
en Ingles deben estar en mayusculas) > Next> Nexto > Finish.

3) Si la computadora no tiene internet

Ingresar el cédigo de activacion que se encuentra en la caja de instalacion del Flexill (Note que las letras
en Ingles deben estar en mayusculas) > Next> Registre el ID y nombre completo de la PC > Use una
computadora con navegador Google Chrome vy visite https://www.saicloud.com/ e ingrese a la

configuracién de la cuenta> Elija: “License manager” can not link?> Ingresar ID y nombre del computadora

antes resgistrado> Create License Now > Download License >regresar al interfaz de instalacidn.: Importar
archivo de Licencia A> elegir descargar license-xxxxx.lsn> Open > Finish.
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https://www.saicloud.com/

3. Quitar software
Start > Flexill folder> License Manager> Remove License From This Computer> record the remove

code> Finish.
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(1)Si la computadora tiene internet
Usar navegador Google Chrome para visitar https://www.saicloud.com/ >ingresar a la configuracion de tu

cuenta> Encontrara que su estado estd inactivado, eso singnifica que el software ha diso removido de su

compu
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(2) Si la computadora no tiene conexién a Internet
Use una computadora que use navegador Google Chrome para visitar https://www.saicloud.com/>

ingresar en la confifuracion de tu cuenta> Remove Licence ? > Ingresar cddigo de eliminacién> Remove

|
4. Flexill operacidon de corte de contorno
1) Conectar la maquina a la computadora a través del cable USB y encender
2) Abrir la configuraciéon del Production Manager 11> select machine type> Next> Communication Port

COM2 (Refer to device manager) Bits per second : 9600 Bat Bit : 8 Check : None Stop bit : 1

Sequential control : Hardware > Finish
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Doble click en plotter device>Cut> Tickear knife offset> ingresar el

3) Fijar la compensacién de valor:

valor.
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4) Corte: Abrir FlexiSTARTER Jinka Cloud Edition 11y hacer un patrén>Cut/Plot> Enviar.

5) Flexill Corte de Contorno: abrir Flexi y hacer un patron> Effects> Contour cut> Apply> Effects>
Contour Cut Mark> 4 point> adjust the distance value (1.000cm or more)> Apply> Print> place the paper
and locate the origin> OK> send> locate the registration mark> OK> OK.

~ \ Place the printed pagpe unto
¥ o= iamy =1 NO 1 regisiration mark the machine

Click"':-”key to move

red dot to the center

el of the cross on the

paper
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Atencion

1) Al finalizar el proceso de corte de contorno, notara que la linea de contorno no coincide con el
cuadrado impreso. Por favor use la regla para asegurar la distancia entre ambos cuadrados. Calcular el
valor real de la compensacion de acuerdo con la siguiente férmula.

- OffsetY=0-a Offset Y =0 +a

OffsetX=0-b a Ofiset X=0-b

O cada vez usted revisa cambie el valor Offset Y=0 Offset X=0

OffsetY=0-a OffsetY=0+a

da a
I Offset X=0+Db OffsetX=0+b

3) Ingrese los valores de Offset entrada X y Offset entrada Y en el cuadro de dialogo de Flexi Cut Contour.
Cut Contour > Options > Edit > tick Offset X and Offset Y > ingresar el valor > OK
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